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Rational Insight and Rational System Atchitect Integration Guide

Rational Insight and Rational System
Atchitect Integration

Introduction

This guide provides instructions for producing a simple report from Rational Insight
using Rational System Architect repositories. Although you can generate report from live
data sources as well, the scope of this document is to provide instructions for generating
reports from data stored in a data warehouse.

The figure shown below indicates the phases required to generate a report.

* Data Manager # Data

Data retrieved Warehouse

from Data Manger

stored in Data Eeporting based on data

Warehouse stored 1n Data Warehouse

¥
Eational
System > XML D ata. A Framework A Report
e Configuration Live IManager Generator
Eeporting

The overall tasks for generating reports from a data warehouse are as follows:
e  Generate a XDC file using XML Data Configuration.
e Model the physical database in the Data Manager by using the XDC file.
e  Extract the data from Rational System Architect through the ETL process.
e Model the metadata and publish packages using the framework manager.

e  Publish the report using the browser.
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Generating the XDC file using XML Data Configuration

Generating the XDC file using XML Data Configuration

Generate the XDC with the XML Data Configuration as follows:

1. Start XML Data Configuration.

2. Click File>Create Configuration. The New Configuration dialog is displayed.
3. Enter a file path in the Location field and a name in the Name field.

4. Click OK.

Once the New Connection is created you need to create the following items:
e  (Create Resource Group
e  Create Resource under the Resource Group

e  (Create Data Mapping Templates
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Creating Resource Group

The XML Data Configuration gets loaded with a tree structure.

1. Right click on Resource and select New> Resource Group. The new Resource
Group dialog is displayed.

* New Resource Group . @ﬁ

Create a Resource Group \

Specify a name, description, and authentication type for the new resource group. Selecta |/ O
URL type, enter the URL, and click Finish.

Name: SystemArchitectDefinition
Description: Retrieval of System Architect Definition through REST API
Authentication type: |Mone M
URL:
® Data service

* hitp://localhost:8889/SARest/SQL/TLOGICS A/libnettest/ 1] ~|
@] Generic XML

[ Link to existing resource group

Mame URL

Test Connection...

@ Einish l l Cancel
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Generating the XDC file using XML Data Configuration

2. Enter values for the Name and Description fields.

3. Chose the Authentication Type as None. Ensure that the client logged in to this
machine has sufficient access to Rational System Architect encyclopedia repository
from where the information is fetched.

4. Provide the REST URI in the Data Service field. The REST URI should be
specified till the workspace level.

5. Click on Test Connection to validate the connection to the REST URI. Click

Finish after testing the connection.

A message box informs you if the connection is successful. If the connection is not
successful, the message box displays a “Connection Refused” message. This means
that the Rational System Architect REST Service is not running on the specified
machine.

Creating Resource under the Resource Group

1. Right click on the above created Resource Group to create Resource under it.
2. Enter values for the Name and Description fields.

3. Select the Locate using data service and click Next. The encyclopedia tree panel is
shown.

4. Select the class node in the right side of the tree.
5. Check the href and name checkboxes and click Next.

6. Select the Definitions URI and click on Next. The Definition tree panel is
displayed.

7. In the XML schema pane, select the type node.

8. In the Element attributes pane check the href and name checkboxes and click
Next.

9. Select the definition type to generate for your report and click Finish.
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Creating Data Mapping Templates
1. Right-click on the resource created above, and select New> Data Mapping
Table. The New Data Mapping Table dialog is displayed.

2. Enter values in the Name and Description field. You should enter suitable values,
such as the name “SADefinitionMapping,” and description “Retrieval of Rational
System Architect definitions through the REST APL.”

3. Click Next.

4. Under the Definitions node, select definition your are mapping click Next. The
Create or Select a Data Mapping Table screen is displayed.

5. Select Create a new template, if you do not have an existing template., and click
Next. The Create a Data Mapping Template screen is displayed.

6. Enter values for the Name and Description fields and click on Next.

7. Define the XML data to Relation Table Mapping, as shown below.

&' New Data Mapping Table @

Define the XML-to-Relational Table Column Mapping

Double-click an element or attribute in the XML schema tree to create its relational table column mapping. You can
also select an element or attribute and click Create.

XML schema: Refresh Relational table columns:
[e] Distributior_A_ XPath Table C...| SQL... | L. | P... | S| MN...| Pri
[€] Effective-s /Rank Rank INTEG... O
[€] Identity [Mame Name VARC... 256 m|
[€] Initial-spa- /GUID GUID VARC... 256 O
(€] Tnitial-spa- /Description  Descript... VARC... 256 |

[e] Initial-spa-
[e] In-spa-Ser
(= Interface-¢
[e] Last-spa-C

[e] Last-spa-C

[e] Last-spa-c|_ |

[e] Perpetual-

[e] Reference-
[e] RelatedDe_

PN PR S

(<] ey

m

@ Finish l ’ Cancel
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Model the physical database in the Data Manager by using the XDC file

8. Click Finish when you are done mapping.

9. On the newly created Data Mapping Template, richt-click and select Open. The
Data Mapping between the XML and the Relation Table is shown below. If errors
arise they are displayed at the top of the window. This step completes process of
generating the XDC files.

| * XML Data Configuration C:\InsightFiles\SAlnsightXDCFile\SADataDefinition.xdc =
Fie [dr Joois Wndow Help
= R
= L ML Datn Configuration O SADefnitionData [
= Dakn Mapping Tampistes § .
« it SADelibionbiots Data Mapping Template: SADefinitionData
: :c’m'“nn Mappings * Genersl Information
e iiphivis Feevide general information abet this dota mappng template.
£ SysemirchtedDefiniion
# 1) Appheationdefinition tinme: SADefinexaDats
Retrieval of System Archtect Definition thiough REST APL
Deseription:
= Column Mappings
Descrive the XML-tc-ralationnl table column mapping dafined by this dats mapping template.
XML schema! Relationsl table columas:
| XFath Table Column Na...  SOL Typs Length Fracs..  SC..  ldishie  Frimary Key
[greste | e Harme VARDUAR 36 5] o
[Renrie Fennie DTRGER = o
(D G VARCHAR 36 = ]
Ieseription Deseription VARCHAR 254 a o

- Data Mapping Tables
List a8 the data mapping Lables that are atsociated with this dats mapping template.

Data Mapping Table Harme Destrigtion
da £ad
Description

Model the physical database in the Data Manager by using the

XDC file

Once the XDC file is created, the Data Manger is used to configure the physical
database from which the information retrieved from Rational System Architect will be
stored under the data warehouse. The steps for creating the Data Manger are as follows.

The overall steps you need to take in Data Manager are as follows:
e Create /Open the Catalog.
e Import the XDC files created through XML Data Configuration.

e Import the Data from Rational System Architect into the Data warehouse.

Create/Open the Catalog
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The catalog in Data Manager stores all the configuration information.

1.

To run the Data Manager, click the Start> Program Files> IBM Rational

Insight> IBM Cognos 8> and sclect Data Manager.

Click the Create a new catalog icon. You can also click Open an existing catalog

if you have one.

In the New Catalog dialog, enter values for the Name, Business name and

Description fields.

Click Next.

Choose the database server that you are using, as shown below in the example

below.

New Catalog

Cancel |

Sioez

5 INFORMIX-Connect

Fiooec

5 Oracle SOL*Net

1 50L Server (OLE-DE. |

51 Svbase [CT-Libram)
< 5]

|lzername ;

Paszword :

[v Use'windows Logon

Server Mame

|nagabsss"~sqle:-:press

Databaze Mame

= o

|S.-5'-.InsightD ataRetrival

OLE DB Prowvider :

| zglnch [SOL Server 2005 native clhent)

T est Connection

=]

< Back

Finizh

Help

6. Choose the authentication mechanism, and enter values for the Server Name and

7. Click Test Connection. A message box displays test results.

Database Name fields.
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Model the physical database in the Data Manager by using the XDC file

If it the test fails, an Error dialog is displayed with error information.
If the test succeeds, a message box displays “Connection OK.”.

Click Finish when the connection test succeeds.

Click OK to continue.

Import the XDC files created through XML Data Configuration

In the Data Manager, proceed as follows:

1.
2.
3.

Click Tools and select ODBC Administratot....
The ODBC Data Source dialog is displayed.

Click the System DSN tab and click Add. The Create New Data Source dialog is
displayed.

Select IBM Rational Insight XML ODBC Driver and click Finish.
Enter values in Data Source Name and Description fields.

For the Configuration field, click Browse and locate the XDC you created through
the XML Data Configuration wizard.

Click on OK on all the opened dialogs.

Import Data from Rational System Architect into the Data warehouse

In the Data Manager, proceed as follows:

1.

2
3.
4

Right-click Builds and JobStreams and select Insert Folder.
Enter values for the Name, Business name, and Description fields and click OK.
Create a folder hive under the folder you created above as necessary.

Right-click on the Connections node to create new connection to the ODBC driver
you created for the XDC file.

Choose the Data source name which you specified in the IBM Rational Insight
XML Data ODBC Setup.

Click on Test Connection to check the connection. If the connection succeeds, a
“Connection OK” message is displayed.

Rational Insight and Rational System Architect Ingetration Guide 9
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7. Click OK once the connection succeeds.

8. Right-click on the connection node to create a new connection to the Rational
System Architect Data Source, where the data retrieved from Insight will be stored.

9. Specify the Data source name, which will be storing the data retrieved from
Rational System Architect in Rational Insight. As shown below, the data retrieved
from the Rational System Architect SQL server will be stored in the database name
RISA.

-,

rSADataRetrived - Connection Properties

General Connection Details l

5 Cognos Data Source |zermame :
Sioe: |
075 Package [OLE-DE)
1 Esshase Pazsword :
5 INFORMI%-Cornect |
= oDeC
3 Oracle SOLMet v UseWindows Logon

=3 Publizhed FM Package

500 5 ({OLEDE] Sermver Mame :

& SQLT;.:.VH |nagabsss"~sqlewpress ﬂ o
53 5ybaze [CT-Library) Database Mame -

=L [FilSA

OLE DB Provider :
| saloledb [SAL Server 2000 OLEDE) |

Collation zequence :

Test Connection |

Ok | Cancel | Help |

10. Click Test Connection to validate the connection.

11. In the Data Manger window, expand the Builds and JobStreams folder.
12. Right-click on the ApplicationDefinition subfolder and select Insert Fact Build
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Model the physical database in the Data Manager by using the XDC file

to initiate the data transfer from Rational System Architect to Rational Insight.

Create a Data Source

In the Data Manager Window, create a Data Source on the above created Fact as
described below.

1.
2.
3.

Right-click on the DataStream folder and select Insert Data Source.
In the General tab, enter values for the Name and Description fields.
In the Query tab do the following tasks:

o Select the data source which was specified in the IBM Rational Insight XML
Data ODBC Setup.

o Expand the nodes and select the Rational System Architect data in which you
are interested. Right-click on the selected node and click on Add table select
statement.

The Query tab now displays the Query statement, as shown below.
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% Application - Data Source Properties

General  Query l Result cnlumnsl Literal$] Derivatinnsl \-"ariablesl

Database
|S.&InsigthataConneclinn j Mew
D atabaze ohjects - Cluern &
E a SalnzightD ataConnection SELECT "Rank™,
ﬁgﬁ Systern "Wame™,
Flay SystemdrchitactDsfirition "EUIDT,
L - "Description"
[+ f !
E-E 2 "DATRASOURCE ID™
FROM "SystemArchitectDefini
< ] 11l | [ }]
Advanced >
Test
L o] ]| =]
0k Cancel Help

Optionally, click Test to check the data retrieval from Rational System Architect.

5. If the data retrieval from Rational System Architect succeeds, click the Result
Columns tab and click Refresh. The selected data will turn to the output as desired

columns.

6. Click OK to close the Data Source Properties panel.
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Model the physical database in the Data Manager by using the XDC file

AutoMapping to Database

In the Data Manager Window, create a Data Source on the above created Fact as
described below.

1. Right-click on the Data Stream, and select Properties to perform the mapping.
2. Click Auto Map.

3. Right-click on Transformation Model, and sclect Mapping. The Rational System
Architect data is transformed and mapped to the desired database selection.

Click Auto Map, and select Create New Element as Attribute.

Right-click on the Fact Delivery, and select Insert Relational Table Delivery.
Enter a value in the Name field in the Table Delivery dialog,.

Click the Table Properties tab.

Select connection as SADataRetrieved.

A R A

Click on the button next to Table Name.
Note: In Rational Insight , SADataRetrieved is the name of the connection to the
database that will store the information retrieved from Rational System Architect.

10. Specify a Table name in the Table Name field.

11. Click Execute under the context menu displayed on the Fact Build. The data will be
fetched from Rational System Architect and stored in the data warehouse.

12. Click OK on the Execute Build dialog. If the data transfer from Rational System
Architect is successful then amount of data transferred is shown in the console
window.
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Framework Manager
Once the data is the Rational Insight data warehouse, you use Framework Manager to
model metadata and publish packages.

Before starting Framework Manger, you need to ensure that the Data Warehouse is
configured to the correct database and that the sign on user is created. By default
Rational Insight points to the “SAMPLEDW?” data warehouse when it is installed.

The instructions that follow point you to a “RISA” data warehouse, as an example.
Therefore, you need change the data warehouse to “RISA.” Please refer to “Data
Warehouse Change and Signon Creation” section (pg. 23) which describes how to
change the Data Warchouse and create a sign on uset.

To start Framework Manager proceed as follows:

1. Click the Start> Program Files> IBM Rational Insight> IBM Cognos 8> and
select Framework Manager.

2. Execute each of the following tasks in the Framework Manager (each task is detailed
in the sections that follow):

e Create or open a project.
e (Create a new query subject on a project.

e (Create and publish a new package.

Creating or opening a project

Rational Insight provides some out-of-the-box (OOB) projects. You can use the existing
OOB projects and model your data or create a new project. The instructions in this
section are for creating new project. A project is a set of files that define the metadata in
one or more models. Models represent data source information.

3. Click on the Create a new project... hyperlink in the Framework Manager.

4. Enter values for the Project name field (for example, “SARationallnsight”), for the
Location field, and click OK.

5. Select a language in the Select Language field and click OK.

6. In the Metadata Wizard, select Data Sources, since the data pulled from Rational
System Architect is stored in the database. This data was pulled from Rational
System Architect through the Data Manager.

14 Rational Insight and Rational System Architect Ingetration Guide



Framework Manager

10.

11.

Click Next to choose the database under the selected data source.

Select RISA from the data source list. This is the database that stores the Rational
System Architect data pulled through Data Manager.

Click Next.

Select dbo from the object list since the data from Rational System Architect was
stored in this object which was pulled through Data Manager.

Click Next. The Metadata Wizard dialog shows the following options:

Rational Insight and Rational System Architect Ingetration Guide 15



Rational Insight and Rational System Atchitect Integration Guide

Metadata Wizard - Generate Relationships

)i

f | e
J i {
Relationships are created for you during the import of your data. Select the critera to use to
generate relationships.

»

Select at least one criteria to detect and generate relationships.

[+ Use primary and foreign keys
[ Use matching guery item names that represent uniguely indexed columns
| Use matching query item names

Select between which set of objects you want to detect and generate relationships.
{* Between the imported query subjects
" Between each imported queny subject and all existing queny subjects in the maodel
" Both

Indicate how you want to generate relationships between the imported queny subjects.
QOuter joins:

" Convert to inner join {1..n)

Granularity:

I+ Fact detection enabled {1..n, 0.}

Help Cancel < Back | Import |

o

12. Click Import. Once the import is done the project will be loaded.
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Framework Manager

Creating a new Query Subject on a project
Once the project is loaded you can insert a new query, through the Query Subject
context menu, as described below.

1. Enter a name in the Name field and chose Data Source (Tables and Columns),
since the data is being retrieved from the tables.

2. Click OK. The New Query Subject Wizard is displayed.

3. Select RISA from the data source list. The Run database query subject wizard
checkbox should be checked.

4. Click Next. The following options are displayed.

5. Select the table from the data source list.

Rational Insight and Rational System Architect Ingetration Guide 17
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New Query Subject Wizard - Select Columns

¥

3

Database objects

=-{] RISA
--[if RIsA
- dbo
-7 Tables
—=I-{B SADataPulledFromR
Rank
Mame
GUID
Description
DATASCURCE_
£ Views
{7 Synoryms
] Procedures
m Functions
m System Objects
sys

[
|

¥
@+++++

I{_I 1] |

Included columns

SADataPulledFrom RationalInsight . Rank
SADataPulledFromRationallnsight. Name
SADataPulledFromRationalInsight GUID
SADataPulledFrom RationalInsight . Descr
SADataPulledFromRationalInsight DATA

Iil 11T |

< Back

6. Click Next.

The subsequent dialogs provides an option where you can modify the data through
some logical expression and filtering. As an example, the dialogs below show how
modify the data with the relevant information to your requirements.
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Framework Manager

ew Query ject Wizard - Select Joins

S5 (S

Columns included in projection list:

B SAINSIGHTDATATESTING.IDENTITY
AIMSIGHTDATATESTING .RANK
AIMSIGHTDATATESTING.DESCRIPTION
AINSIGHTDATATESTING . NAME
AINSIGHTDATATESTING GUID
SAINSIG HTDATATESTING. TYPE_NAME

~

o/

Join Expression:
And/Or | Expression |

All the selected columns are from the same table and no join is required.

I
i
A

A Filter Expression is shown below.
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\'-. .-‘f = | B— < \\
5 ) G

‘New Query Subject Wizard - Select Filters X
. =

Columng included in projection list:

{ /:SADataPulledFrom Rationallnsight. Rank
SADataPulledFrom Rationallnsight . Mame
SADataPulledFrom Rationallnsight GUID
5ADataPulledFromRationallnsight . Description
SADataPulledFromRationallnsight DATASOURCE_ID

Filter Expression:

SADataPulledFromPationallnsight."Rank” < 5

< Back Mext > Cancel

N

7. Click Next. The dialog below query subject, with the modifications you made for
the example.
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Framework Manager

New Query Subject Wizard - Finish
— i s

Pressing Finish will modify the querny subject with the values provided.
Select

SADataPulledFromRationalnsight. " Fank ",
SADataPulledFromRationalnsight. Mame,
SADataPulledFromFationallinsight GUID,
SADataPulledFromRationallnsight. Description,
SADataPulledFromRationalinsight. DATASOURCE_ID
From
[RISA]. SADataPulledFromRational Insight as SADataPulledFrom Rationallnsight
Where
SADataPulledFromRationallnsight."Rank" <« 5

Test 25 Rows Count

Test Results
Rank Mame GUID Descrip
1 First App 353df 70c-6 B4 -4552-a581-75alfh 766a 14 First Application Inititalisation
i Second App 1185bbde-324c-4815-85a8-25c2be 220550 Second Application Inititalisal
3 Third App Gleall0e-337-404f-9023b4deS11adb3c Third Application Inittalisatior
4 Fourth App Tbd5374b-6oe(-44ce-bEbEfd T0abad ¥ Fourth Application Inititalisatic
[( ] it | [ > l

< Back Cancel |

8. Click Test to validate the query against the Rational System Architect data
warehouse.

9. Click Finish to insert a query object in to the project.

Creating and Publishing a new package

Once the query object is inserted, you have to create a new package and publish it.
Create the package as described below.
1. Right-click on Packages node, and select Create> Package.

2. Enter values for the Name, Description, and Screen tip fields.
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10.

Ensure that the query object selected below is included in the package in the screen
displayed below.

Select SQL server as the function sets. If you have stored the database in some
other data source then select the appropriate data source.

Click Finish. The following dialog is displayed.

-,

SARationallnsight * - Framework Ma...

fl You have successfully created your package.
& Would you like to open the Publish Package wizard?

Yes Mo

Now that the package has been created, it has to be published though the publishing
wizard.

Click Yes. In the dialog shown, note the folder location where the package will be
published. You will need this folder location later when you publish the report.

Click Next. The access control of user on the published package can be controlled
through the dialog shown.

Add the necessary user and click Next.
Click Publish to publish the packages.

Click Finish. If there are any errors or warnings found during package publishing, a
Verify checkbox.

Publishing Reports

Once the package is published using the framework manager the report can be generated
using the published package. The steps for generating the report is mentioned below

22 Rational Insight and Rational System Architect Ingetration Guide



Data Warehouse Change and Signon Creation

B b=

10.

11.
12.

13.
14.

Open the browser window and enter the URI http://localhost:9080/insight/setvlet.
The screenshot shown below is displayed
Click on Report studio in the menu shown below to open the report generating UL

Navigate to your desired folder and select the Package which was published through
the Framework Manager.

Click on the SARationallnsightProject package which was published in the
Framework Manager; the package opens in the Reporting UL

Click on the Create a new report or Template to create new report. Click the
Existing Template icon if you prefer to open an existing one.

Chose the list item and click OK to produce a sample report with a list of
definitions.

The reporting UI opens with the list view. The query object is populated in the tree
view in the explorer window.

Traverse to the SARationallnsightQuery query object in the explorer window.
This query object was created in the Framework manager.

Switch to the Toolbox pane to drop the relevant controls on the report editing
window.

Drag and drop the table control on to the editing window.

Drag and drop the necessary fields from the SARationallnsightQuery query object
in to the table.

Click on the Run Report in the Report Ul to generate the report.

The output report is as shown below. You can export it to Microsoft Excel,
Microsoft Word and other formats.

Data Warehouse Change and Signon Creation

In Rational Insight, you have to change the data warehouse to point to point to the data
warehouse where the Rational System Architect information is stored. You can do so
with IBM Cognos Administration, as follows.

1.

Open the browser window and enter the following URI:
http://localhost:9080/insight/servlet.

The IBM Cognos Connection screen is displayed with the Public Folders tab
selected.
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10.
11.

12.
13.

14.

15.
16.

O the toolbar, click on query drop-down field and select IBM Cognos
Administrator.

Click the Configuration tab.

Click RISA in the data source list. It contains the table from where the information
pulled from Rational System Architect is stored.

Click on the properties icon, (left of the More... link.).
Click the Connection tab.

Click the Edit the connection string icon (right of the Connection string field).
Ensure that the data warehouse RISA is selected as the Database name value.
Select RISA if is not the currently selected data warehouse.

After you configure the database, from the Configuration tab, click the New
Signon icon to create a signon user.

In the New Signon Wizard screen, enter a unique name in the Name field, and
optionally, enter values in the Description, and Screen tip fields. Ensure this
signon user is added to the RISA database in the SQL setver.

Click Next.

Enter values for the User ID and Password fields, and click Next. The Select the
users screen is displayed.

To add users and groups that can use the signon, and click Add....

To choose from listed entries, click the appropriate namespace, and then select the
check boxes next to the users, groups, ot roles.

Click the right-arrow button to add entries from the Available entries column to
the Selected entries column.

Click OK.

Click Finish. The new data source signon now appears in the Type field in the
Connection tab.
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IBM Support

Contacting IBM Rational Software Support

Prerequisites

If you cannot resolve a problem with the self-help resources, contact IBM® Rational®
Software Support.

Note: If you ate a heritage Telelogic customer, you can find a single reference site for all
support resources at http://www.ibm.com/software/rational/support/telelogic

To submit a problem to IBM Rational Software Support, you must have an active
Passport Advantage® software maintenance agreement. Passport Advantage is the IBM
comprehensive software licensing and software maintenance (product upgrades and
technical support) offering. You can enroll online in Passport Advantage at
http://www.ibm.com/software/lotus/passportadvantage /howtoenroll.html.

e To learn more about Passport Advantage, visit the Passport Advantage FAQs at
http://www.ibm.com/software/lotus/passportadvantage/brochures fags quic

kguides.html.

e For further assistance, contact your IBM representative.

To submit a problem online (from the IBM Web site) to IBM Rational Software
Support:

e Register as a user on the IBM Rational Software Support Web site. For details
about registering, go to http://www.ibm.com/software/support/.

e Be listed as an authorized caller in the service request tool.


http://www.ibm.com/software/rational/support/telelogic/
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/support/

Other information

For Rational software product news, events, and other information, visit the IBM
Rational Software Web site: http://www.ibm.com/software/rational/.

Submitting Problems
To submit a problem to IBM Rational Software Support:

17. Determine the business impact of the problem. When you report a problem to IBM,
you are asked to supply a severity level. Therefore, you need to understand and
assess the business impact of the problem.

To determine the severity level, use the following table.

Severity | Description

1 The problem has a critical business impact:
you ate unable to use the program, resulting
in a critical impact on operations. This
condition requires an immediate solution.

2 The problem has a significant business
impact: the program is usable, but it is
severely limited.

3 The problem has some business impact: the
program is usable, but less significant
features (not critical to operations) are
unavailable.

4 The problem has minimal business impact:
the problem causes little impact on
operations or a reasonable circumvention to
the problem was implemented.

Describe the problem and gather background information. When you describe the
problem to IBM, be as specific as possible. Include all relevant background information
so that IBM Rational Software Support specialists can help you solve the problem
efficiently. To save time, know the answers to these questions:
e What software versions were you running when the problem occurred?
e To determine the exact product name and version, use the option
applicable to you:
o Start the IBM Installation Manager and click File > View
Installed Packages. Expand a package group and select a
package to see the package name and version number.
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o Start your product, and click Help > About to see the
offering name and version number.

What is your operating system and version number (including any
service packs or patches)?
Do you have logs, traces, and messages that are related to the problem
symptoms?
Can you recreate the problem? If so, what steps do you perform to
recreate the problem?
Did you make any changes to the system? For example, did you make
changes to the hardware, operating system, networking software, or
other system components?

Are you currently using a workaround for the problem? If so, be prepared to describe
the workaround when you report the problem.
Submit the problem to IBM Rational Software Support in one of the following ways:

Online: Go to the IBM Rational Software Support Web site at
https://www.ibm.com/software/rational /support/. In the Rational
support task navigator, click Open Service Request. Select the
electronic problem reporting tool, and open a Problem Management
Record (PMR) to describe the problem.

For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html.

You can also open an online service request by using the IBM Support
Assistant. For more information, go to
http://www.ibm.com/software/support/isa/faq.html.

By phone: For the phone number to call in your country or region, visit
the IBM directory of worldwide contacts at
http://www.ibm.com/planetwide/ and click the name of your country
or geographic region.

Through your IBM Representative: If you cannot access IBM Rational
Software Support online or by phone, contact your IBM
Representative. If necessary, your IBM Representative can open a
service request for you. For complete contact information for each
country, visit http://www.ibm.com/planetwide/.
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Notices

© Copyright IBM Corporation 1986, 2011.

This information was developed for products and services offered in the U.S.A. IBM
may not offer the products, services, or features discussed in this document in other
countries. Consult your local IBM representative for information on the products and
services currently available in your area. Any reference to an IBM product, program, or
service is not intended to state or imply that only that IBM product, program, or service
may be used. Any functionally equivalent product, program, or service that does not
infringe any IBM intellectual property right may be used instead. However, it is the uset's
responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described
in this document. The furnishing of this document does not grant you any license to
these patents. You can send written license inquiries to:

IBM Director of Licensing
IBM Corporation

Nortth Castle Drive
Armonk, NY 10504-1785

For license inquiries regarding double-byte character set (DBCS) information, contact
the IBM Intellectual Property Department in your country or send written inquiries to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country
where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS
MACHINES CORPORATION PROVIDES THIS PUBLICATION “AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied
warranties in certain transactions. Therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes
are periodically made to the information herein; these changes will be incorporated in
new editions of the publication. IBM may make improvements and/or changes in the
product(s) and/or the program(s) described in this publication at any time without
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notice.

Any references in this information to non-IBM Web sites are provided for convenience
only and do not in any manner serve as an endorsement of those Web sites. The
materials at those Web sites are not part of the materials for this IBM product and use of
those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (if) the mutual use of the information which has
been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation

1 Rogers Street

Cambridge, MA 02142

US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it
are provided by IBM under terms of the IBM Customer Agreement, IBM International
Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment.
Therefore, the results obtained in other operating environments may vary significantly.
Some measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available systems.
Furthermore, some measurements may have been estimated through extrapolation.
Actual results may vary. Users of this document should verify the applicable data for
their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM has
not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those
products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the names
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of individuals, companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is entirely
coincidental.

Copyright license

This information contains sample application programs in source language, which
llustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to IBM, for
the purposes of developing, using, marketing or distributing application programs
conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested
under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability,
or function of these programs.

Each copy or any portion of these sample programs or any detivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are detived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 2000 2011.

If you are viewing this information softcopy, the photographs and color illustrations may
not appear.

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies. A
current list of IBM trademarks is available on the Web at “Copyright and trademark

information” at www.ibm.com/legal/copytrade.html.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States,
other countries, or both.

Other company, product or service names mentioned may be trademarks or service
marks of others.
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